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BAB III 

METODE PENELITIAN 

 

A. PENDEKATAN DAN JENIS PENELITIAN 

Penelitian kali ini saya menggunakan pendekatan kuantitatif dengan 

rancangan one grup pre test-post test design.361 Penelitian ini dilakukan dengan 

melakukan perlakuan yaitu dengan belajar menggunakan media audio visual.  

Pada penelitian ini hanya menggunakan satu kelas tanpa ad akelas 

pembanding. Pada penelitian ini dilakukan sebanyak dua kali yaitu sebelum 

menggunakan media audio visual dan sesudah menggunakan media audio visual. 

Tes yang dilakukan sebelum menggunakan media audio visul disebut pre test 

sedangkan tes yang dilakukan sesudah menggunakan media audio visual disebut 

post test.  

 

Table 1 - Rancangan One Grup Pretest-Posttest Design 

Angket Perlakuan Angket 

Pretest Treatmen Posttest 

 

 

 
36 Yanti Puspita Sari, “Penerapan Model Pembelajaran Sains Teknologi Masyarakat 

(Stm) Untuk Meningkatkan Hasil Belajar Siswa Pada Konsep Hubungan Sumber Daya Alam 

Dengan Teknologi.” (Universitas Pendidikan Indonesia, 2017). 
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B. LOKASI PENELITIAN 

Tempat merupakan suatu tempat dimana yang kita teliti ini. Pada 

penelitian ini akan dilakukan di Madrasah Ibtidaiyah Negeri 14 Hulu Sungai 

Tengah yang berada di Jl. Datu Aria RT. 01 RW. 01 Kecamatan Pandawan.  

C. POPULASI DAN SAMPEL 

Menurut Suharsimi Arikunto, populasi adalah keseluruhan subyek 

penelitian, apabila seseorang ingin meneliti semua elemen yang ada dalam wilayah 

penelitian, maka penelitinya merupakan penelitian populasi.372 Populasi yang akan 

menjadi penelitian disini yaitu keseluruhan siswa kelas IV MIN 14 Hulu Sungai 

Tengah, yang berjumlah 42 orang siswa.  

Sampel adalah sebagian kecil dari jumlah dan karakteristik populasi. 

Berdasarkan pendapat di atas, penulis dapat menyimpulkan bahwa sampel adalah 

bagian dari populasi. 

1. Populasi 

Populasi adalah semua jumlah orang dari keseluruhan yang akan diteliti. 

Jadi, karena disini peneliti akan meneliti siswa pada kelas IV MIN 14 Hulu Sungai 

Tengah, maka haruslah tahu ada berapa semua jumlah siswa yang berada pada kelas 

IV tersebut yaitu ada 42 siswa. Saat melakukan penelitian pada populasi, biasanya 

menggunakan sampel untuk mewakili dari populasi tersebut.  

 

 
37 Suharsimi Arikunto, Prosedur Penelitian Suatu Pendekatan Praktik (Jakarta: Rineka 

Cipta, 2010) 
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2. Sampel 

Sampel adalah sebagian yang diambil dari keseluruhan penelitian populasi 

tersebut. Nilai yang akan di hitung dan di peroleh dari populasi ini disebut juga 

dengan parameter. Sampel dapat diambil dari semua anggota populasi yang ada, 

yaitu siswa kelas IV MIN 14 Hulu Sungai Tengah yang berjumlah 42 siswa.  

Table 2 – SampelPenelitian 

No. Kelas Jumlah Siswa 

Laki-laki Perempuan 

1. IV 14 28 

Total 42 

 

D. DATA DAN SUMBER DATA 

1. Data 

Data adalah hasil pencatatan peneliti, baik berupa fakta ataupun angka. 

Data didefinisikan sebagai segala fakta dan angka yang dapat dijadikan bahan untuk 

Menyusun suatuinformasi, sedangkan informasi adalah hasil dari pengolahana data 

yang dipakai.383 Data adalah sesuatu yang tidak memiliki arti bagi penerima dan 

perlu diproses. Data dapat berupa gambar, suara, huruf, angka, dan sebagainya. 

2. Sumber Data 

Sumber data adalah dimana data tersebut dapat diambil. Apabila peneliti 

mengumpulkan data dengan menggunakan kuesioner, maka sumber data tersebut 

 
38 Rahmadi, Pengantar Metodologi Penelitian (Antasari Press: 2011) h. 70 
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disebut responden.394 Penyedia informasi diperoleh dari anggota guru dan staff 

tatausaha. Penelitian dokumenter berupa data tentang isi penelitian dan foto-foto 

kegiatan. 

E. TEKNIK PENGUMPULAN DATA 

Adapun teknik pengumpuan data yang peneliti gunakan dalam penelitian 

ini, yaitu antara lain sebagai berikut:  

1. Angket 

Angket merupakan teknik pengumpulan data dengan cara memberi 

seperangkat pertanyaan atau pernyataan tertulis kepada responden untuk 

dijawab.405 Angket merupakan alat penting dalam proses pengumpulan data 

penelitian. Informasi yang diberikan dalam kuesioner biasanya lebih rinci dan 

menjawab pertanyaan penelitian. Angket dilakukan untuk memperoleh data 

motivasi belajar siswa dalam proses pembelajaran menggunakan media 

audiovisual. Angket berisi serangkaian pernyataan yang diberikan kepada siswa 

untuk mengetahui motivasinya dalam belajar. 

2. Observasi 

Observasi dapat didefinisikan sebagai pengamatan sistematis berkenaan 

dengan perhatian terhadap fenomena-fenomena yang Nampak. Observasi 

digunakan untuk mendapatkan data hasil pengamatan. Observasi yaitu kegiatan 

yang sering di lakukan dalam penelitian. Observasi artinya perhatian dan 

pengamatan. Kegiatan observasi memiliki tujuan agar mendapatkan kondisi, 

 
39 M M Johni Dimyati, Metodologi Penelitian Pendidikan Dan Palikasinya Pada 

Pendidikan Anak Usia Dini (PAUD) (Kencana, 2013). 
40 Mania Siti, Sulaiman, PengantarMetodologi Penelitian (Pusaka Almaida: 2019) h. 90 
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keadaan, serta situasi dari obyek yang akan di teliti. Pengamatan yang dilakukan 

dan pencatatan sistematis terhadap objek yang di teliti agar mendapatkan data-data 

mengenai gambaran umum dan fenomena yang tampak pada peserta didik tentang 

motivasi belajar siswa pada kelas IV MIN 14 Hulu Sungai Tengah. 

3. Dokumentasi 

Dokumentasi adalah teknik pengumpulan data untk data yang sudah siap 

atau data sekunder. Dokumentasi merupakan gambar atau foto-foto selama 

penelitian berlangsung serta digunakan sebagai bukti bahwa melakukan penelitian. 

F. INSTRUMENT PENELITIAN 

Instrument penelitian yaitu alat bantu yang dipakai oleh peneliti untuk 

mengambil data agar menjadi lebih gampang dan sistematis. Instrument ini juga 

diartikan sebagai alat ukur penelitian dalam melakukan pengukuran data kuantitatif. 

Table 3 - Kisi-kisi Instrumen 

Motivasi 

Belajar 

Indikator Sub Indikator + - Jumlah 

1. Semangat a. Semangat dan 

rajin dalam 

belajar 

b. Sekolah tepat 

waktu 

1, 2 

 

 

4 

3 

 

 

- 

3 

 

 

1 

2. Ketekunan a. Keributan di 

kelas 

b. Memperhatikan 

pelajaran 

5 

 

7 

6 

 

8, 9 

2 

 

3 

3. Keyakinan 

dan 

keberhasilan  

a. Adanya niat dan 

keinginan 

supaya berhasil 

  

10, 11, 

12 

- 3 

4. Berusaha a. Mencari 

informasi 

mengenai 

Pelajaran 

13 

 

 

 

- 

 

 

 

1 
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b. Berusaha 

mengulang dan 

mengingat 

Pelajaran 

14 - 1 

5. Kemandirian a. Bertanya jika 

ada yang tidak 

dipahami  

b. Berani 

menjawab 

pertanyaan 

yang 

ditanyakan 

guru 

15, 16 

 

 

18 

17 

 

 

19, 20, 

21, 22 

3 

 

 

5 

 

Skor angket 

Table 4 - Skor Angket 

No Respon Nilai 

Positive Negatif 

1 Sangat Setuju 4 1 

2 Setuju 3 2 

3 Tidak Setuju 2 3 

4 Sangat Tidak Setuju 1 4 

 

G. HASIL UJI COBA INSTRUMEN 

Untuk hasil percobaan instrumental, kuesioner adalah alat yang berguna 

untuk memperoleh jawaban. Uji distribusi kuesioner dilakukan untuk mendapatkan 

data tersebut. Penelitian perlu mengetahui kelayakan suatu kuesioner (kuesioner) 

untuk diisi oleh responden, sehingga perlu dilakukan uji validitas dan 

reliabilitasnya. 
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1. Validitas 

Validasi adalah proses yang dilakukan peneliti untuk mengumpulkan data 

dan menarik kesimpulan yang dihasilkan oleh evaluasi instrumen. Tes ini 

dijalankan untuk melihat apakah kuesioner tersebut valid atau tidak. Uji validitas 

dilakukan dengan membandingkan nilai r hitung (Pearson Correlation) dengan 

nilai r tabel. Dengan membandingkan nilai r-hitung (Pearson Correlation) dengan 

nilai r-tabel, digunakan sebagai tolak ukur untuk menunjukkan valid tidaknya item 

kuesioner. Jika r hitung lebih besar dari r tabel, maka dinyatakan valid. Sebaliknya, 

jika r tabel lebih besar dari r r hitung, maka tidak valid.416  

Uji validitas pada penelitian ini dengan menggunakan analisis SPSS.Hasil 

output dari SPSS dibandingkan dengan rtabel. Jika N= 42 dengan taraf signifikansi 

5% adalah 0,304. Jadi, jika nilai r hitung > r tabel dikatakan valid segitupun sebaliknya 

nilai r hitung < r tabel dikatakan tidak valid.  

Table 5 - Valid dan Tidak Valid 

No Pernyataan Yang Valid No Pernyataan Yang Tidak Valid 

2, 4, 5, 7, 8, 10, 11, 12, 13, 14, 15, 16, 

17, 18, 19, 21, 22 

1, 3, 6, 9, 20 

Total = 17 Total = 5 

 

 

 
41 Budi Darma, Statistika Penelitian Menggunakan SPSS (Uji Validitas, Uji Reliabilitas, 

Regresi Linier Sederhana, Regresi Linier Berganda, Uji t, Uji F, R2) (Guepedia, 2021). 
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Table 6 - Hasil Uji Validitas 

No 

Soal 

r hitung r tabel Keterangan 

 No 

Soal 

r hitung r tabel Keterangan 

1 -0,128 0,304 Tidak Valid 12 0,423 0,304 Valid 

2 0,479 0,304 Valid 13 0,414 0,304 Valid 

3 0,303 0,304 Tidak Valid 14 0,722 0,304 Valid 

4 0,333 0,304 Valid 15 0,628 0,304 Valid 

5 0,613 0,304 Valid 16 0,726 0,304 Valid 

6 0,273 0,304 Tidak Valid 17 0,803 0,304 Valid 

7 0,557 0,304 Valid 18 0,645 0,304 Valid 

8 0,517 0,304 Valid 19 0,683 0,304 Valid 

9 -0,006 0,304 Tidak Valid 20 0,294 0,304 Tidak Valid 

10 0,456 0,304 Valid 21 0,521 0,304 Valid 

11 0,723 0,304 Valid 21 0,390 0,304 Valid 

 

2. Reliabilitas 

Uji Reliabilitas yaitu mengukur variabel-variabel yang digunakan dalam 

pernyataan yang digunakan. Pengujian dilakukan dengan membandingkan tingkat 

signifikansi menggunakan nilai alpha Cronbach. Taraf yang digunakan bisa (0.5), 

(0.6), atau (0.7). Jika nilai Cronbach’s alpha > tingkat signifikansi maka dinyatakan 

reliabel. Sebaliknya, alpha Cronbach <; tingkat signifikan dinyatakan tidak 

reliabel. 
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Berikut beberapa kategori dalam pengambilan keputusan pada Uji 

Reliabilitas:  

1. Reliabilitas rendah apabila Cronbach’s alpha < 0,6 

2. Reliabilitas moderat apabila Cronbach’s alpha 0,51 – 0,70 

3. Reliabilitas tinggi apabila Cronbach’s alpha 0,71 – 0,90 

4. Reliabilitas sempurna apabila Cronbach’s alpha > 0,91 

Uji reliabilitas pada penelitian ini menggunakan SPSS dengan nilai 

Cronbach’s Alpha, apabila nilai reliabilitas diatas 0,6 maka dinyatakat reliabel. 

Begitupun sebaliknya, jika nilai reliabilitas kurang dari 0,6 maka dinyatakan tidak 

reliabel. 

Table 7 - Hasil Uji Reliabilitas 

Reliability Statistics 

Cronbach's Alpha N of Items 

,870 17 

 

Hasil uji reliabilitas menunjukkan bahwa koefisien Cronbach’s Alpha 

yaitu 0,870 sehingga dapat dikatakan reliabel. Analisis mengungkapkan bahwa 

instrumen ini cocok untuk mengukur variabel penelitian 
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H. TEKNIK ANALISIS DATA 

1. Deskriptive Statistic 

Pengukiran deskriptif statistic ini perlu dilakukan untuk melihat gambaran 

data secara umum, seperti; nilai rata-rata (Mean), tertinggi (Maximum), terendah 

(Minimum) dan Standar Deviasi dari variabel. 

 

Analyze → Descriptive Statistic → Descriptives → Pindahkan Motivasi Pretest dan 

Posttest ke Variables → Option → Centang Mean, Max, Min, Std. Deviation  →  

Continue →  Ok 

 

2. Uji Normalitas 

 

Merupakan uji prasyarat mengenai kelayakan data agar dapat dianalisis 

menggunakan statistic parametrik atau statistic nonparametric. Statistik parametik 

digunakan data lolos uji normalitas yang berdistribusi normal. Statistik 

nonparametik digunakan data tidak lolos uji normalitas, maka data tidak 

berdistribusi normal.  

 

Analyze → Descriptive Statistic → Explore → Pindahkan Motivasi ke Dependent 

List → Plots → Centang Normality Plots with Test  →  Continue →  Ok 
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a. Jika nilai Sig. Linearity > 0,05 maka motivasi belajar sebelum 

menggunakan media audiovisual dengan motivasi belajar sesudah 

menggunakan media audiovisual berdistribusi normal. 

a. Jika nilai Sig. Linearity < 0,05 maka motivasi belajar sebelum 

menggunakan media audiovisual dengan motivasi belajar sesudah 

menggunakan media audiovisual tidak berdistribusi dengan normal. 

 

3. Uji Homogenitas 

Uji Homogenitas yaitu suatu uji yang dilakukan untuk mengetahui bahwa 

data sampel berasal dari populasi yang memiliki varians yang sama (homogen). Uji 

ini merupakan persyaratan sebelum melakukan pengujian lain. Uji ini digunakan 

untuk meyakinkan bahwa data memang berasal dari populasi yang memiliki varians 

yang sama. 

 

Analyze → Compare Means → One Way Anova → Pindahkan Motivasi ke 

Dependent List dan Kelas ke Factor → Options → Centang Homogenity of 

Variance Test → Continue → Ok 

a. Jika nilai Sig. > 0,05 maka distribusi data bersifat homogen. 

b. Jika nilai Sig. < 0,05 maka distribusi data bersifat tidak homogen 
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4. Uji Gain 

Uji Gain bertujuan untuk mengetahui seberapa besar peningkatan motivasi 

belajar siswa sebelum dan sesudah menggunakan media audiovisual yang dianalisis 

menggunakan uji gain. Adapun rumus yang dapat digunakan dalam menghitung uji 

ini adalah sebagai berikut:  

 

N Gain =  Skor Post Test – Skor Pre Test    x 100 

Skor Ideal – Skor Pretest 

 

Ada terdapat tiga kategori, yaitu skor < 0,3 dengan kategori rendah, skor 

0,3 < <0,7 dengan kategori sedang dan skor > 0,7 dengan kategori tinggi. 

Table 8 - N Gain Score 

N-Gain Kategori 

 g < 0,3 Rendah 

0,3 < g < 0,7 Sedang 

g > 0,7 Tinggi 
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Table 9 - N Gain Persen 

Persentase % Kategori 

 < 40 Tidak Efektif 

40 – 55 Kurang Efektif 

56 – 75 Cukup Efektif 

> 76 Efektif 

 

5. Uji Hipotesis 

Uji T dapat digunakan apabila data berdistribusi normal. Uji ini bertujuan 

untuk mengetahui efektivitas penggunaan media audio visual untuk meningkatkan 

motivasi belajar siswa. 

a. Jika T hitung > T tabel atau nilai signifikansi < 0,05 maka Ha diterima dan 

Ho ditolak. 

Jika T hitung < T tabel atau nilai signifikansi < 0,05 maka Ha ditolak dan Ho 

diterima. 


